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Mobility Fundamentals 
T r a i n i n g  O u t l i n e  

Introductions 

 Discuss Mobility’s purpose and background

Mobility User Interface 

 Navigation & Data Entry

 Road Building Exercise

 Road Log/Fuel Tax/Standards of Good Practice

Inventories 

 Reference Points

 Signs

 CLAS

 Traffic Studies

 Culverts

 Other

Lunch  

Reporting 

 Canned Reports

 Custom Reports

Discussion 

Hands – On 

 Query the Database

 Format Report Layout

 Design a Report Layout

 Export a Layout

 Report File Management of the FTP Site

This class provides users a foundation in the basic operation and function of Mobility. 
Main topics include the Roadlog, Inventories, Canned, and Custom Reports. 

DAY 1  
8:00AM – 11:30 AM 

DAY 1  
12:30 – 4:00 PM 



Mobility Pavement Management 
T r a i n i n g  O u t l i n e  

This class provides users a foundation in the basic operation and function of Mobility’s 
Pavement Management System (PMS). Users will understand what makes up a good Pavement 
System, review pavement related inventories in Mobility, create decision trees, and how to 

configure and run the Pavement Management processes in Mobility.

DAY 2  
8:00AM – 11:30 AM 

Introduction 

 Discuss PMS purpose and background

Create Decision Tree 

 Pre-Planning your decision tree

 Decision Tree Exercise

Run Mobility Pavement Management 

 Generate Projects

 What Analysis

 When Analysis

Review Pavement Management Inventories 

 RoadLog

 Surface History

 Surface Condition

 Planned Projects

 Projects

Generate Pavement Management Reports 

Upon Request 
• Pavement Rating Class

• VisRate Pavement Rating Software
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Create a new Road 

 

In order to add road segments and other inventory features to a new road, you must first create the road. 

Follow the steps below to create a new road.  

1) From the File menu select New OR right-click in the feature list (in the center of the screen), then 

click on New, and choose Road from the menu list. The Create New Road screen displays in 

figure 1. 

2)  Type in the new road number and road name in the fields below and then click the Create New 

Road button. 

The new road displays in the road list (on the left side of your computer screen) as pictured in figure 2 

above. A new reference point displays as 0.000 *unknown* at the top of the Feature List (middle 

pane). You can now add features to the new road (covered below under ‘Create a new record’). 

 

The next step to is modify the new unknown reference point and then define the remaining reference 

points and new road segments for the road.  Follow the steps below to create reference point records. 

 

Reference Points 

 

Reference Points serve two main purposes. They assign road names to sections of a 

road and reference points order and define many segments as a road system network. 

One big advantage of reference points is the location information provided by Mobility dynamically. 

 

Reference Points can be intersections, beginning-ending mileposts, and other county points of interest 

such as but not limited to the following: 

 Landmarks 

 Road Name Changes 

 Pavement Type Changes  

 Pavement Year, Pavement Width, etc. 

 

The Reference Points form now includes fields to assist in Systemic Safety Analysis that works with 

Mobility’s Systemic Safety Project Selection Tool. The fields display to the right of the Ahead field on 

the Description Tab. Safety analysis includes data on intersections, horizontal and vertical curves.  

 

 

 

   Figure 1     

     

                    Figure 2 
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Create an Intersection Reference Point  

1. Either click File on the menu bar and click New then Reference Point OR 

2. Right-click in the Feature List (middle pane), click New then click Reference Point. See Figure 3 

Figure 3 

 

 

A blank Reference Point form shown below displays in the form window (right-pane) Figure 4. 

Figure 4 
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In the Description tab click in the milepost field and enter the milepost of the selected road where the 

intersection is located. The milepost is 0.445 in Figure 4. 

1. Press the TAB key to display the road name in the Road Name field (Note: The road must be in 

Mobility for this to display automatically). 

2. Press the TAB key to advance to the direction Back and Ahead fields. 

3. Enter one of the following:  N, S, E, W, NE, SE, SW, NW, NNE, ENE, ESE, SSE, SSW, WSW, 

WNW, and NNW. 

4. TAB over to the Priority field. Enter a number for the priority. A priority of 1 is sometimes assigned 

to the road with a higher Federal Function Class. This is optional and varies from county to county. 

5. TAB to each field and fill in the remaining fields.  

6. TAB down to next row and enter the road number for the intersecting road (In Figure 4 we are using 

road number 36690 Box Canyon Rd in this example). 

 You will see a diagram of the intersection begin to render in the center of the reference point form.  

 Figure 5 

 

7. TAB over to the Milepost field and enter the intersecting milepost. Note: The road name displays 

automatically in the Road Name field.  

8. TAB over to fill in the direction Ahead and Back fields. 

9. TAB over to the Priority and enter a value for the road priority. 

10. TAB down to the next row and the intersecting road that you have just entered now displays in the 

diagram. Fill in the Additional Information field if needed. 
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11. Select an option from the Intersection Control field. 

12. Enter another intersecting road or click the Save button to save your changes. 

Note:  when you add a new intersecting road the Number of Legs updates automatically when you 

TAB down to the next row. 

 

Create a new Reference Point Record (non-intersection) 

1. From the File menu select New > Reference Point OR right-click in the feature list and click 

New > Reference Point. 

2. Fill in the Milepost field. 

3. TAB to the Road Name field and the Road Name will display automatically. 

4. TAB to and fill in the Back and Ahead fields. 

5. Fill in the Priority field if desired. 

6. TAB to and fill in any remaining fields that you desire to track.  

7. Fill in the Additional Information field if needed.  

8. Click the Save button.  

 

It is a common practice to define your reference points and then create road segment records for a new 

road.  

 

Create a new Road Segment 

 
1. Either go to click File on the menu bar, click New then click Road Segment OR 

2. Right-click in the Feature List, click New then click Road Segment. See figure 6. 

Figure 6  
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A blank road segment form will display in the form window as shown in figure 7 below.  

 

3. Click the Save button to see the information notices that inform you that there are required fields to 

save the road segment record. In this case, these fields are Motor Vehicle Fuel Tax (MVFT) related 

fields. See figure 7. 

Figure 7 

                            

4. Fill in the all of the required MVFT fields and all other fields that you want to track or report on.  

5. Click the Save button to save your data entry. 

  

When you change a MVFT field, or add or delete mileage, the Audit Trail Dialog will display. Document 

your changes using the Comment and Reference # fields as shown in figure 8. 

                  Figure 8 
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Click the OK button and your new record will display in the feature list. Note the “Inventory item 

saved” message in the middle status box at the top of your screen.  

 

Road Log Edit Checks 

 

In the Roadlog you are required to fill in all of the Motor Vehicle Fuel Tax (MVFT) fields to save a road 

segment record. Additionally, Mobility checks to ensure that the Federal Function Class, Urban Area, 

and Federal Route fields are compatible and filled in correctly. See figure 9 below.  

If they are not, you cannot save the record and the fields in question are marked with red circles  and 

triangles . Place your mouse over the highlighted fields to display a tool tip to help you correct the entry. 

  

 

 A Federal Route is now required whenever a road log segment has a Federal Function Class of 

02 (Major Arterial), 06 (Rural Minor Arterial), 07 (Rural Major Collector), 08 (Rural Minor 

Collector), 12 (Urban Principal Arterial, other freeways or expressways), 14 (Urban Principal 

Arterial, other), 16 (Urban Minor Arterial), or 17 (Urban Collector) 

 

 An Urban Area Code is now optional when a road log segment has a Federal Function Class of 

00 (Proposed or projected; private; non-county system road). (Jurisdiction must not be 05) 

   Figure 9 
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Delete a road 

  

To delete a road, you must have administrator rights. Use Delete Road very carefully. Ensure you 

fully understand what you are deleting and the consequences. ALL inventories on the deleted road 

will be deleted too. If you are not sure if this is the correct step to take, please call or email CRAB 

before deleting. 

1) Click on the road that you want to delete in the road list to select it. It will highlighted in blue once you click 

on it.  

2) Click on Admin Tools on the menu bar. 

3) Click the Delete Road button and the Confirm Road Delete dialog displays. 

4) Click the OK button to delete the road. 

 

Create a new record  

 

Create all Inventory records the same way no matter what inventory you are using. Follow the steps listed 

below.  

1. From the File menu select New OR right-click in the road list or feature list and then click New 

on the menu. 

2. Click on the type of record that you want to create from the menu. 

3. Enter data in the fields on the displayed inventory form. 

4. Click the Save button to save the record and it will then display in the feature list. 

 

Delete a record 

 

Delete all inventory records using the steps listed below. 

1. In the road list, select the road on which the inventory feature record is located. 

2. Double-click on the record in the feature list to open the record in the form window.  

3. Click the Delete button on the bottom of the form in figure 10 to display the message below. 

Figure 10 

 
 

4. Click the YES button to confirm and delete the record.  

 
Do not forget to fill in the required Motor Vehicle Fuel Tax fields. You cannot save the record unless 

they are filled in. See the online Mobility Help topic under RoadLog/Gas Tax Control Fields for more 

information. 
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Now that you have added reference points and road segments to the road, next comes Mobility Inventory 

items. We will begin with signs. 

 

Signs 

 

Create a new sign record 

 

Creating a sign record is a two-step process. First, create and save the signpost and then add the sign 

plate(s) to the post. Finish by the saving the complete record as outlined in the steps below. 

 

1. Either click File on the menu bar, click New then click Sign OR 

2. Right-click in the Feature List, click New then click Sign. See figure 11. 

 

Figure 11 

 

 

Note:  Check with your Mobility Administrator prior to entering Sign Data or other Inventories that you 

perform maintenance on. You may to decide to set up Maintenance Activities and Codes for each 

inventory. This action will save you steps in data entry and prompt you automatically to choose to create 

a maintenance record for Signs or other Mobility Inventories.  
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If a maintenance, code was linked to the installation. You get asked to add a new maintenance record 

before filling in the SignPost form.  If a maintenance code has not been linked to the installation a blank 

Signpost form will display on your screen (figure 12 next page). 

 

A blank Signpost form will display in the form window.  

 

3. Click the Save button to view required fields to save the record. The field will have an exclamation 

point next to them and a red triangle will display to inform you that there is a required field on a tab.  

Figure 12 

 

 

 

4. Click the date control to select the Date Installed.  

5. Fill in the required Milepost and the Side of Road fields as a minimum, plus any other desired fields. 

You can save the signpost record now. 

6. Click on the blue <edit> text in the Signplates grid in the row that has “Add new record” in the 

legend column to display the Signplate form (figure 13 on the next page). 
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Figure 13 

 

 

7. Fill in the Signplate fields and choose the plate from the Type/Legend field drop-down list.  

8. Click the Save button when you are finished and return to the signpost form and the new sign record 

will display in the feature list.  

 

Delete a sign record 

 

1. In the feature list, double-click the sign record that you want to delete. The sign record’s form will 

open and display in the form window.  

2. Click the Delete button at the bottom of the form.  

  

Confirm the delete operation as shown in figure 14 on the next page. 
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Figure 14 

 

 

3. Click the Yes button to delete the Sign record.  

 

4. If a maintenance code has been linked to the removal, you will get prompted to add a new 

maintenance record before deleting the sign. This allows you to enter the actual date that sign was  

removed, instead of the date that you deleted in from Mobility. If a maintenance code has not been 

linked to the installation, the Sign is deleted when you click the Yes button.  

 

The sign form closes; the sign record is removed from the feature list, and note that the “Inventory item 

deleted message” displays in the status box at the top of the form as pictured in figure 15. 

 

Figure 15 

 

 

To review deleted sign records, you can create a custom report using the qSignHistory view in Custom 

Reports or use the canned Sign History report. 

 

All records in Mobility are deleted in the same manner. You must open the record and press the 
Delete key at the bottom of the form. 

 

Traffic Study 

 

Create a new Traffic Study Station 

 

Counties annually conduct Traffic Study counts on portions of their road system.  With the ever-

increasing importance of Vehicle Miles Traveled (VMT) a current, accurate traffic volume is very 

important.  Traffic studies determine potential Truck Routes (T-1 thru T-5), update the classification of 

existing Truck Routes and for verifying and updating average daily traffic (ADT) volumes. 

 

Traffic Study information is also an integral part of Mobility’s Pavement Management 

System (PMS). Traffic counts are often one of the deciding factors on when, what type, and where a 

county road will receive a Pavement Rehabilitation treatment. 

 

Create a new count station 

 

1. Select the road from the Road List that you want to collect traffic county data. 
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2. Right- click in the feature list.

3. Click New and then click on Traffic Study to display a blank Traffic Study Station

form as seen in figure 16 on the next page.

4. Fill in the desired fields then click the Save button to save the results data to the station.

Figure 16 



Mobility User Training 

 
County Road Administration Board 2016 13 

5. Information entered into the Count Station ID field will display in the feature 

list when the record is saved as shown in figure 17. 

Figure 17 

 

 

6. Click on the blue <edit> text in the Traffic Studies Results Grid in the row that has “Add new 

record” in the Comment column to display the Traffic Study Result form show in figure 18. 
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Figure 18 

 

 

Update the Road Log with the Traffic Study results. 

 

7. Select All through lanes from the Lanes Studied field (You can only update the Road 

Log when All thru lanes is selected.) 

8. Place a check in the box next to Update Road Log? (All Thru Lanes Studied 

required). 

9. Enter a value in the Volume field. 

10. Enter a value in the End Date field.  

 

11. Select a value in the Source field.  

12. These fields are required to Save the record and update the Road Log.  
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13. You can also update the Truck Route Class in the Road Log from the Traffic Study 

Result form by using the following steps. 

14. Specify whether you are entering Percentages or Counts in the Numbers are: field. 

15. Enter the value in the Total Truck field. 

16. Fill in the values for the Truck-Single, Truck-Double, Truck-Train fields. 

 

These values must add up and match the value in the Total Truck field or the warning icons  will display 

as seen in figure 19. 

Figure 19 

 

 

You can also add values to the Bus and RV fields. They are not included in the counts 

or percentage calculation. These fields get updated in the RoadLog Traffic tab in the ADT section.  
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17. Click the Calc G.A.T button to calculate the Gross Annual Tonnage (G.A.T.). The calculation is 

determined by the values that you entered into the Count or Percent fields 

18. Accept or Select a different value in the Truck Route Class drop-down list field. 

19. Click the Save button to display the Choose Road Log Segments screen in Figure 20. 

Figure 20 

 

 

20. Click to check the box of the Road Log segments to update. 

21. Click to check the box in the lower left corner to update the Truck Route Classification. 

22. Click the OK button and the Audit Trail Dialog screen in Figure 21 displays. 

23. Fill in the Reference # field. 

Figure 21 

 

 

24. Click the OK button to save the transaction to the Audit Trail. 

 

The road segments specified in figure 20 (above) update with new Traffic and Truck Route data. You can 

now open and review the updated data in the Road Segment records. 

 

See the following sections in this manual and Mobility’s Online Help for more information on Mobility 

Inventories, Pavement Management, Custom Reports, Systemic Safety Project Selection Tool, and the 

Mobility Map. 
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Remember! 

 

1. Look in this manual and Mobility’s Online Help. 

2. Your support is a phone call or email away.  360-753-5989 

3. We can do a remote session by phone and computer. 
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Mobility Reports – Canned Reports 

 

Mobility includes a set of canned reports that can quickly generate a formatted report. You can choose to 

export or print the reports. We continue to add canned reports when we receive feedback reports from 

county staff. See page three in this section for Custom Reports. 

 

Create a canned report 

 

1) Click on Reports on the Mobility menu bar and select the area of interest for your report. Each area 

has several reports listed with it. This example uses the Roadlog Summary Report. Click on Reports 

on the menu bar and then Inventories ►Roadlog ►Roadlog. 

 

2) Fill in the fields in the top section to specify your criteria for the returned record set. For this example, 

the filters selected were Road Number 63551, Jurisdiction = County, Function Class = any, 

Pavement Type = any, Sort: Road  

3) Click the Generate button to create the report. The report will display as pictured in figure 1. 

  

Figure 1  

 

 

 

Print or Export a canned report 

1. Click the Print button (3rd button from the left on the report tool bar).  

2. View the prompt and select the printer name, number of copies, etc.  

 

You can export canned reports in several different formats. The steps for exporting canned reports and 

custom reports are identical.  

 

1. Click the Export Report button (2nd button from left on toolbar) to display the Export screen shown 

in figure 2 on the next page. 
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2. Click the triangle on the Export Format field to display the drop down list.  

3. Select a format from the list. We chose Microsoft ® Excel in figure 2. 

 

Figure 2     

 

 

4. Click the OK button to open the Save As screen shown in figure 3. 

5. Navigate to your county folder on the CRAB ftp site. 

6. Type in a meaningful filename. 

7. Click the Save button to save the exported report.  

Figure 3 

 

 

The Excel Export Complete message displays in figure 4.  

8. Click the OK button to close the message 

Figure 4 
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Mobility Custom Reports 

 

Mobility’s Custom Report Designer provides a great deal of flexibility and detail not possible with 

canned reports. CRAB has created ‘views’ of different parts of the database.  This not only provides 

security; it also makes data retrieval much easier for you.  Build custom reports around the data retrieved 

by the views. 

 

Create a custom report  
 

To create a custom report, you must first query the Mobility database to return the fields that you want 

included in your report. Mobility queries use Structured Query Language (SQL) to tell the database what 

fields to return.  Click Reports on the Mobility menu bar and then click Custom to display the Custom 

Report Designer (figure 5).  

 

              Figure 5   

 

 

Report Designer (figure 5 above) 

1. Menu bar: File: Commands include New, Open, View Report, Page Setup, Save, and Exit 

Query: Opens the Query Tool screen. 

Edit: Commands include Undo, Redo, Cut, Copy, Paste, Delete, Select All  

2. Fields box. Your query’s fields display here when you successfully create a query. 

3. Tool Bars: The top tool bar contains File and Edit commands. The lower toolbar contains 

formatting commands.  

4. Toolbox: Contains objects that you can click to move to the report design grid. 

5. Design Grid: Drag and drop fields from the fields box to the detail section of the design grid to 

view your data when you view your report.  

6. Properties List: Use the properties list to format objects and perform calculations. 
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Query the database 

In the following sections, we will work with the qPMSRehabs (Pavement Management Rehabilitations) 

topic. We will query the database, drag and drop the query’s fields onto the report design grid and format 

the report. These steps will work for all Mobility Inventories’ custom reports. 

 

1. At the Custom Report Designer screen, click Query on the menu bar to display the  

 Query screen shown below in figure 6.  

 

2. Click on one or more topics in the Choose Topic(s) list to display views available for your 

chosen topic(s) in the Choose View list.  

 

3. Click on a view to see the available fields display in the Choose Fields list. A description of the 

selected view displays in the grey box located below the list. 

  

4. Click on the fields that you want to add to the query from the Choose Fields list. Click on fields 

and they display automatically in the query text box when clicked, including the SQL required 

syntax of the SELECT and FROM clauses. See detailed instructions on how to customize queries 

on page eight.  

In figure 6, the Pavement Management (PMS) topic is selected (check marked and highlighted on the left) 

and that topics’ available database views display in the Choose View pane (in the center). 

The qPMSRehabs view is selected and the fields available for that view display in the Choose Fields 

pane. Figure 6 displays the selected fields. 

        

       Figure 6 

   
  

5. Execute the query by clicking the OK button. If the query runs successfully, the selected fields 

display in the Fields box of the Custom Report Designer as shown on the upper right in Figure 7 

item 1 on the next page.  
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Move fields to the report layout 
 

The fields in the ‘Fields’ Pane must now be move to the Detail section on the report design grid. 
You can design reports to display data in an attractive format.  

Alternatively, you can display data in a format more suitable for exporting to Excel. Many counties export to 

excel to manipulate, perform calculations and export data into their county GIS systems. 

 

 
Move individual fields 
 

1) Click on a field in the field list to highlight it.  

2) Hold the left mouse button down and drag the field over to the Detail section of the report design 

grid. Drag the field toward the left margin of the detail section and then release the mouse button. 

3) Repeat these steps to place the remaining individual desired fields on the report layout. 

 

 

Move all fields or a contiguous set of fields  
 

1. Click on the first field in the list. Press and hold the SHIFT key down and then click on the last 

field in the list (or the last field in the list that you want to add to the report). Continue to hold the 

mouse button down after clicking on the last field. Let go of the SHIFT key, continuing to hold 

the left mouse button down. Do not let up on the left mouse button. 

2. Drag the fields near the top-left margin in the Detail section of the report design grid.  

3. Let go of the mouse button. The fields will be visible in the report design grid. See  

figure 7 item 2. 

 

Figure 7 
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Move only some fields or non-contiguous fields 

 

1. Click on the first field needed for the report.  

2. Press and hold down the CRTL key and then click on the other fields that you need for the report.  

3. Continuing to hold the left mouse button down, let go of the CTRL key and drag your fields to 

the Detail section of the report design grid. 

4. To move fields around on the report design surface, click on the field, and hold the left mouse 

button down, move the field to the desired location. 

 

Move the Page footer just underneath the fields in the detail section to improve readability and 

remove extra space when you view the report.   

1. Place your mouse over the top border of the Page Footer section. Double vertical arrows will 

display. See item 3 in figure 7 on the previous page. 

2. Double click when you see the vertical arrows. This will close up the extra white space in the 

detail section of the report.  Alternately, place your mouse at the top of the page footer border and 

drag the footer up when the double arrow displays.  

 

Sizing fields and objects 

 

See figure 8 for sizing objects. 

1. Click on a field to select it. Selection squares will display on the selected object (figure 8 item 1). 

2. Place your mouse over the center selection square on the desired side. Horizontal arrows display 

(figure 8 item 2). 

3. Hold your left mouse button down and drag to increase or decrease the size of the field object. 

Figure 8 

 

       

Selecting Multiple Objects        

 

There are multiple methods to select more than one field object or any report object such as labels and 

textboxes: 

1. Click anywhere in the section you are working in and then press the CTRL + A. 

2. Click on the first object. Press and hold down the CTRL key and click on the remaining objects 

that you want to select.  

3. Place your mouse pointer in the white margin to the left of the ‘line’ that you want to select and 

click the left mouse button. All the objects in that ‘line’ are now selected. Note: this method is 

very precise about where the mouse is located. It may take a few tries to get it to the correct place 

in the left margin. 

**Click in any blank area of the report design grid to deselect an object. The selection squares do not 

display when no objects are selected.  
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4. Place your mouse pointer anywhere in a white section on the Report Design Surface. Click the 

left mouse button and hold it down. Drag the mouse so that a box draws around the objects. The 

box you draw selects all objects that it touches. 

5. Click the mouse on the title of the section to change. It will turn blue.  Click on Edit (on the Menu 

Bar) and then click ‘Select All’. This will select all fields in that section.   

 

 Display data in the report 
 

Position the fields in the detail section shown in figure 8 on the previous page. 

1. Click on File ►View Report on the menu bar at the top left of the screen. 

Your report will display on the Report Preview screen as shown in figure 8-1. 

 

 Figure 8-1 

              
 

You now have 2 options. You can export the returned data to another file format (spreadsheet or other) to 

your county folder on the CRAB ftp site. Alternately, you can continue to design the report in Mobility 

and save the report to your county folder.  

2. Click the X “close button” at the top right corner of the screen to return to the Report Designer 

screen.  

** Users on Remote Desktop Services (RDS) can save report layouts and export report files to their 

county folder on the CRAB ftp site. To obtain your exported reports, go the Internet and browse to your 

county folder on the CRAB ftp site (ftp://ftp.crab.wa.gov/). Copy exported reports down to your local 

computer (Spreadsheets, .PDF, etc.) and then remove them from your county folder on the ftp site. 

Reports designed in Mobility have a .rpx file extension and can remain in the county folder on the ftp site 

for future use.  
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Writing and Customizing Queries  
 

Custom reports allow users to be creative with data retrieval. To retrieve data, SQL (Structured Query 

Language) is used within the Mobility reporting tool. Users must specify what data to select, and where 

it comes from.  
 

SQL ‘select’ statements must have, at a minimum, 3 parts:  

1. The keyword ‘Select’ 

2. The data being selected (field names) 

3. Where the data will come from (a view name in Mobility), using the keyword ‘from’ 

Example: 

Select fieldname1, fieldname2 from ViewName  

 

Mobility Custom Reporting Hints 

 

 Field names are NOT case sensitive (bmp = BMP)  

 Enclose fields in [brackets] if the field name contains more than one word. 

e.g.  [Road Name] needs brackets, but EMP does not. 

 Fields must have a comma separating them. Do not put a comma after the last field in the list.  

 SQL ignores multiple spaces and line breaks in the query.  If a query is easier to read by 

placing the different ‘sections’ on different lines or indenting a section, SQL will ignore  

everything except the text for the query.  

 Enclose text strings and dates using an opening and closing apostrophe, e.g. ‘[Property Damage]’ 

 The between operator is inclusive - both the beginning value and ending value will be included 

  in the selection. 

 Several different criteria can be specified in the where clause. 

 Parentheses should be used to separate logic (‘and’ and ‘or’) in the where clause.  ‘And’ will  

 take precedence over ‘or’. 

 The auto type feature works in the SELECT portion of the query only. You must type the 

WHERE, ORDER BY, GROUP BY clause fields and criteria manually. The auto-type feature 

works for the initial selecting of the desired fields. After you add a WHERE, ORDER BY, or a 

GROUP BY clause(s) you must manually type in any fields that you wish to add to the select 

clause. 

 The Mobility Report Designer can handle formatting, field sub-totals, running totals, grand totals, 

summing and counting. 

 A line of the query (except required parts) can be commented out rather than deleted by typing 

two dashes (--) at the beginning of the line. This line will be ignored by SQL when the query  

 executes. 
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SQL query examples 

 

The examples below demonstrate some of the various features and capabilities of SQL: 

   

  Basic selection statement, which would be created by clicking on the fields 

  in the ‘Choose Fields’ list: 

 Select [Road Number], [Road Name], BMP from qGuardrails 

   

  WHERE 

Specifies criteria for the selection 

  Select [Road Number], [Road Name], BMP from qGuardrails  

where [Jur Code] = 5  

 

SORT 

Order the data 

 Select [Road Number], [Road Name], BMP from qGuardrails 

   where [Jur Code] = 5  

  order by [Road Name] 

 

WILDCARDS 

Select all fields from the view 

Select * from qCulverts   

(Note that larger, more complex views such as qRoadLog can take several minutes to 

complete.) 

 

Any number of characters in place of % can be used before and/or after word(s) 

Select [Road Number], [Road Name] from qRLShort 

where [Road Name] like ‘Yelm%’ 

 

Select  [Road Number], [Road Name] from qRLShort  

where [Road Name] like ‘%yellow%place%’ 

 

NOT/ < > (not equal to) 

Select records that do not have specified criteria 

Select [Road Number], [Road Name], BMP, Hazard from qGuardrails 

where not ([Anchor Cond] =  7) 

 

Select [Road Number], [Road Name], BMP, Hazard from qGuardrails 

where [Anchor Cond] < >  7 
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BETWEEN 

Select records with criteria falling within a range of values  

  Select [Road Number], [Road Name], MP, Legend, [Jur Code] from qSigns 

where [Date Post Installed]  

between ‘01/01/02’ and ‘12/31/02’ 

 

Select [Road Number], [Road Name], MP from qSigns  

where [Road Number]  

between 20000 and 29090 

 

DISTINCT 

Displays unique values, evaluating entire ‘row’ for duplicates 

  Select distinct [Road Name] from qRLShort  

  where [Road Number] = 11415 

 

IN 

Select records with criteria in a defined list 

Select [Road Name], [Road Number] from qGuardrails  

where [Jur Code] in (02, 06, 07) 

 

Combine with NOT 

Select [Road Name], [Road Number] from qGuardrails  

where [Jur Code] NOT in (02, 06, 07) 

 

GROUP BY 

Combines records into groups in preparation for use with sub-totals  

Select [Road Number], FFC, [Thru Lane Surf] from qRLShort  

where [Jur Code] = 5 and ADT > 500  

group by [Road Number], FFC, [Thru Lane Surf] 

Order by FFC, [Thru Lane Surf] 

 

NULL/NOT NULL 

Not the same as an empty field.  Syntax is different! Do not use ‘= NULL’ (equal sign) or 

‘<> NULL’  

Select distinct [Road Number] from qRoadLog  

where [Acct ID] is null 

order by [Road Number] 

 

Select distinct [Road Number] from qRoadLog 

where [Plat Name] 

is not null order by [Road Number] 
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Formatting Custom Reports 

 

Report “objects” include all items and sections of report the report design grid including labels, text boxes 

and data fields. These objects all have “properties”, such as font size or color that can be assigned. 

Calculations and other formatting capabilities are possible. Modify a report object’s properties in the 

Report Designer’s Properties Window as described below. 

 

   

 

The two most common objects used and formatted on a report will be labels and text boxes (figure 9). 

Formatting will help in designing a professional report. The table below displays suggested uses for labels 

and text boxes. The next few pages cover creating and formatting labels and text boxes.  
 

Figure 9 

 

NOTE: If you misplace a report object, or accidentally delete an object from the report layout:  Press 

CTRL + Z. This is the undo command and you can undo several steps by pressing and holding the 

CTRL key down while pressing the Z key. Alternately, you can use the   Undo button on the 

toolbar. 

  Label and Text Box Functions 

Label Text box 

Report Title Calculations 

Report Headings Functions  

Page Numbering Grouping 

Labeling report sections or groups  
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Add report labels 

1. Click on the Label tool  from the Section Reports toolbox on the left side of the screen. 

2. Move your mouse over to the design grid in the PageHeader section. 

3. Your cursor will change to a cross hair  (figure 10). Draw a box in a left to right motion 

starting the bottom-left corner moving to the top right corner and let go of the mouse button. OR 

4. Click on the label tool,  move your mouse over to the design grid in the PageHeader 

section. 

5. Double-click to display the new label object. 

 

Your label objects will look similar to labels 2 & 3 in the figure 10 PageHeader section. 

Figure 10 

 

 

6. Create a label directly above each data field in the PageHeader section (figure 10 above). 

7. Click the Snap Lines button on the toolbar below the report design grid (figure 11) to display 

blue align guides to help you align fields both vertically and horizontally as shown in figure 12.  

 

Figure 11 

 

 

 Figure 12 
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8. Click a label and type in the desired name for the column heading.  TAB over to the next label 

and type in the text for that label. Repeat to finish naming each label (figure 13). 

Your report labels display at the top of each page as column headers for your data fields. You can size 

label objects the same way as field objects on page 6 in figure 8. 

 

Figure 13 

 

 

 Left-align each label above each field to align your report headings and fields using the blue snap lines in 

figure 12 on the previous page.  Alternately you can you use the buttons on the formatting tool bar. Place 

your mouse over each button to view a tooltip of what each button does. See figure 14.  

 

 Figure 14 

  
 

8. Click on File ►View Report on the menu bar at the top left of the screen. 

Your report displays with column names at the top of each page.  

 

Using the Property List 

 

Modifying an object’s properties enables you to add color, font type, alignment and other formatting 

attributes. When you click on an object, its properties will display in the Properties Window.  Follow the 

steps listed below to change the properties of an object.  

 

Formatting object properties  
 
In this example, we will use the property list to change the font style to bold. 

 

1. Click on the object to format and selection squares display on the object (object is selected). 

 

The property list display will change based on what object or objects that you select. The selected objects’ 

properties display options or attributes that you can change.  
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Select multiple objects: 

 

2. Click one label and then press, hold the CTRL key down, and click other objects that you want to 

format at the same time (selecting multiple objects).  

 

Use step 2 to select all the labels at once. All of the label objects display selected in figure 15. 

 

All the labels in the PageHeader section are selected. 

 
Figure 15 

  
 

3. Click the Font property in the Appearance section of the property list (figure 15 above). 

4. Click the three-dot box to display the Font screen in figure 16. 

5. Click Bold in the Font style window.  

 
Figure 16 

 
 

 

6. Click the OK button and the selected labels display in bold font (figure 17next page). 
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Figure 17 

 
 

7. Preview your report by clicking the  button at the bottom of the report designer shown in 

figure 18. 

 

This allows you to preview the first ten pages without leaving the report designer. 

 
             Figure 18 
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8. Click on File ►View Report on the menu bar to view the entire report as shown in figure 19. 

Figure 19 

      

 

Column headings display at the top of every page. Next, we will look at the PageFooter object. Content in 

a page footer will display at the bottom of every page. 

 

1. Click the close button on the report preview screen to return to the report designer screen (figure 20). 

Figure 20 
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Refer to figures 21 & 22 for steps 2 & 3. 

 

2. Place your mouse at the bottom of the page footer to display vertical arrows. See figure 21. 

3. Hold your left mouse button down and drag the border down a bit to give you enough space to add 

some content (figure 22). 

 

Figure 21 

 

 

Figure 22 

 

 

4. Click on the ReportInfo object from the toolbox. 

5. Drag it over to the PageFooter section and let go of the mouse. See figure 23. 

 

Figure 23 
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6. Click on the ReportInfo object in the PageFooter to select it. 

7. Click on FormatString in the property list. 

8. Click on the chevron (triangle) to display the list in figure 24. 

9. Click on the 2nd item in the list: . 

10. Note the change in the ReportInfo1 object in the PageFooter in figure 24. Compare it with figure 23. 

 

Figure 24 

        

 

11. Click on File ►View Report on the menu bar to view the report. 

12. Scroll down through the report to see the page numbering at bottom of each page (figure 25). 

 

Figure 25 

 

        

Next, we will add a new section to the report. See Report Header & Footer on the next page.  

 

 

 

 

 

 



Mobility User Training 

 
County Road Administration Board 2012 19 

Report Header & Footer 

Inserting a report header and footer adds two new sections to the report. Any objects added to the report 

header will display only on the first page of the report. Any object added to the report footer will display 

only on the last page of the report. 

 

Add a report header & footer 

 

1. Right-click anywhere on the Report Design Surface,  

2. Click Insert, and then click Report Header/Footer (figure 26). 

 

Figure 26 

 
 

The report now has two new sections: ReportHeader1 and ReportFooter1. See figure 27 

 

      Figure 27 
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You can add labels, textboxes, and other report objects to the ReportHeader1 and ReportFooter1 

sections. These options make your report a more descriptive and informative document. We will use some 

of these options in the next steps.  

 

Remember! Once you create and save a custom report in Mobility, it becomes your own report and you 

can open it any time in the future. It will contain the most current data every time you open it. Save the 

report with a different filename each time you open it. This will help you maintain a history of the 

specific report data for analysis and to determine trends.  

 

Add Objects to the Report Header 

 

See figures 28-30 to visualize the following steps for adding objects to the report header section. 

 

1. Click on the Label tool  from the Section Reports toolbox to draw 2 labels near the 

left margin of the ReportHeader1 section of the report. See the Add report labels heading on 

page 12 for a refresher. 

2. Enter your County name in the first label object you created. 

3. Enter a title for your report in the second label object.  

4. Click the ReportInfo object from the Section Reports toolbox and draw it near the middle of the 

ReportHeader1 section. See figure 23 on page 17 if you need help. 

5. Click to select the ReportInfo object (selection squares will display) indicating it is selected.  

6. Click the Picture tool from the Section Reports toolbox and draw a box near the right margin in 

the ReportHeader1 section.  

 

The ReportHeader1 section of your report should now look similar to figure 28. 

 Figure 28 

  

 

7. Click the box you just drew for the picture to select it (figure 29 next page). 
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8. Click the Image property in the Properties list and then click the 3-dot box (figure 29). 

 

Figure 29 

 

 

9. Navigate to your County folder on the CRAB ftp site using  the Open screen in figure 30. 

10. Select your image and click the Open button. This will display your image in the picture box in 

the ReportHeader section of the report (figure 31).  

 

Figure 30 

 
 

 Figure 31 

  

 

Note: You must first copy images to your County folder on the CRAB ftp site to put them in a custom 

report.  
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11. Click on File ►View Report on the menu bar to view objects added to the report header and the 

column headings in figure 32. 

 

Figure 32 

 

 

 

Grouping and Calculations 

 

In the remaining sections, we will create calculations with textboxes. We will add a new section, the 

GroupHeader/Footer section to the report. Summary information and calculations go in this new 

section. Additionally, this helps you learn how to add a grouping level to your report. 

Use text boxes to perform calculations and store functions.  Perform count, sum, average, and other 

calculations with text boxes. Put textboxes in most sections of the report except for the detail section. 

Reserve the detail section of the report for database fields only.  

 

Add a Group Header & Footer Object 

 

1. Right-click anywhere on the report design grid. 

2. Click Insert, then click Group Header/Footer to display the new section in the report (figure 33). 

 
Figure 33 
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The new GroupHeader/Footer section in figure 34 displays in the report. 

 Figure 34 

  
 

GroupHeader1 in figure 34 above highlights in blue. This means it is selected. You can click any blank 

area of the report to deselect it.  

Next, we are going to specify the Rehab Year field to group the report. We will add a calculation for the 

rehabilitation cost for each Rehab Year (Rehabilitation Year).  

 

3. Click the GroupHeader1 section if not already selected. It will highlight in blue. 

4. Click on the DataField property in Data section of the property list on the lower right. 

5. Click on the triangle to display a field list.  

6. Click on the REHAB YEAR field to select it and link it to the GroupHeader1 object. 

 

We have just specified that we want to group this report by the REHAB YEAR (Rehabilitation Year). 

See figure 35.  

 

 Figure 35 

  

 

7. Place your mouse on the top of the Detail section border. Vertical arrows will display. 
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8. Drag it up to reduce the white space in the GroupHeader1 section. See figure 36. 

 

Figure 36 

 
 

Closing up the white space in GroupHeader1 will allow more records to display on each report page. 

 

Next, we will draw a textbox in the GroupFooter1 section for our calculation (figure 37). The calculation 

will display below each Rehabilitation Year when you view the report. It will show the costs involved for 

each Rehabilitation Year.  

 

9. Click on the Textbox tool  from the Section Reports toolbox on the left side of the 

screen. We want to draw the text box under the REHAB COST field.  

10. Move your mouse over to the design grid in the GroupFooter1 section. 

Your cursor will change to a cross hair.     

11. Draw a box in a left to right motion starting the bottom-left corner moving to the top right corner 

and let go of the mouse button.  

The GroupFooter1 section should look similar to figure 37. 

 

Figure 37 
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12. Click the TextBox object if not already selected. Selection squares display on the object. 

13. Click on the DataField property in Data section of the property list. See figure 38. 

14. Click on the triangle to display a field list.  

15. Click on the REHAB YEAR field to select it and link it to the text box object. 

Figure 38 

 

 

We have just set the calculation of the REHAB COSTS to the text box. The calculation will display at 

bottom of each REHAB YEAR.  

We are almost there! We will now specify what type of calculation we want. For this example, we want a 

subtotal of Rehabilitation Costs for each Rehabilitation year. 

16. Select the textbox if not still selected.  

17. Click the bold button  on the formatting toolbar.  

 

This will make the calculation easier to spot when you view the report. 

18. Go to the properties list and scroll down if needed, to the Summary section.  

19. Select the property attributes in figure 39.  

 

Figure 39 

 

 

20. Finally, lets add a label object to the left of the textbox in GroupFooter1 (for descriptive 

purposes). 

21. Click the bold button  on the formatting toolbar to make the label object bold.  

22. Type in Rehab Year Cost Subtotal in the label object. 
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 It should look similar to figure 40. 

 Figure 40 

  

 

23. Click on File ►View Report on the menu bar to view the entire report as shown in figure 41. 

 

The grouping level by REHAB YEAR and a subtotal displays for each REHAB YEAR listed in the 

report. 

 Figure 41 

  

 

Remember to save your work often as you go!!! 

1. Click on File ►Save or Save AS. 

2. Navigate to your county Mobility folder on the CRAB ftp site. 

3. Enter a meaningful filename if this is your first time saving the report.  

4. Click the Save button. 

 

You can open your reports or ones created by other county users. 

1. Click on File ►Open. 

2. Navigate to your or another County’s folder. 

3. Select a report to open and review it. 
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4. Save it to your county folder under a new name if you like it. 

5. Review the query code for accuracy before using someone else’s report.  Mobility Support can 

help you if needed.  

 

**The report will open with your county data. You can only save reports to your county folder.  

 

It is important that you copy exported reports to your computer. Delete them from your county folder 

after you review them locally. This will save space in your county folder. Each county gets 40MB of 

space for saving reports and map files. See your County Mobility Administrator for more information.  

We have just scratched the surface. You learn more about this tool every time that you use it. Like any 

new skill: Practice, Practice, Practice! Your reports will look great. Rely on your peers as resource. They 

have created some awesome reports. CRAB’s Mobility Support team is here for you too! Please use us. 

That is it for now. We have done a lot of work. This work pays off the next time you need this report. All 

the formatting is complete. Save it the next time that you open it with a different filename to maintain 

your report data history. 

  

 

 

NOTE: You can load report layouts from other county folders. They will display YOUR county data when 

viewed. You can only save report layouts (.rpx files) in YOUR county folder and the CRAB folder. 

Exported reports (.xls, .pdf etc.) will display your data when opened. Locate your exported reports 

in your Mobility County folder on the CRAB ftp site on the internet. Copy exported reports to your 

local PC. Review, save, and print them from your computer – then you can delete the exported 

reports from your county ftp folder to save space. Contact your Mobility Administrator if you have 

questions. 
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1. Initialize Mobility Map 
 
1.1 Upload Road Base Layer to CRAB FTP 
 
The process for creating spatial layers from Mobility’s linear inventories requires a base layer of a 
counties road system (Road Base Layer).  There are many file types for spatial layers; Mobility requires 
that the road base layer be of the ESRI Shape file type (.shp).   
 
The additional requirement for the road base layer is that it include the following attributes:  Road 
Number, From Milepost,  and To Milepost.  Attributes for an ESRI Shape file are kept in an 
accompanying file with the same name, but instead of the .shp extension will have a .dbf extension.  For 
example, your road base layer should consist of two files: 
 
 Road_Layer.shp 
 Road_Layer.dbf 
 
If you have questions on how to obtain theses files you will need to contact your county GIS 
department. 
 
After you have obtained the appropriate files remote Mobility users will need to upload them to the 
CRAB FTP site.  The address for this site is:  ftp://ftp.crab.wa.gov/Mobility.  Open your county’s ftp 
folder, then open the folder named “MobilityMap.”  Copy and paste your files (.shp and .dbf) into the 
“MobilityMap” folder.  For organizational purposes, feel free to create subfolders in “MobilityMap” and 
paste your files into those folders. 
 
Mobility only requires the road base layer for the mapping tool to be functional; however, you can 
upload additional spatial layers if you were to find them useful in Mobility.  For example, you may 
choose to upload spatial layers for bodies of water, urban boundaries, county boundary, etc.  Keep in 
mind that your county is limited to a 40MB storage limit on our FTP site.  This storage limit includes map 
layers, report exports, report formats, etc. 
 
1.2 Initialize Mobility Map 
 
After the road base layer has been uploaded, see section 1.1, the map tool can be initialized for your 
county.  This initialization process will create spatial layers for the linear Mobility inventories.  This is 
done by computing the spatial coordinates for Mobility inventory records from distance measurements 
in the road base layer. 
 
The Mobility map initialization process can only be performed by a Mobility administrator.  To access 
the map initialization screen, click “Initialize Map…” from the “Admin” menu (Figure 1.2 A). 
 
 
 
 
 
 
 
 

ftp://ftp.crab.wa.gov/Mobility


Figure 1.2 A 
 

 
  
After accessing the map initialization screen take a few seconds to read through the instructions.  Before 
clicking continue, identify the road base layer.  This can be done by clicking the hyperlink labeled “here”  
(Figure 1.2 B).  A file open dialog will appear, navigate to the “MobilityMap” folder on the CRAB FTP for 
your county, and select the road base layer, e.g., road_layer.shp, and click “Open.”   
 
Figure 1.2 B 
 

 



After the road base layer has been identified the drop down lists for road number, from milepost, and to 
milepost will be populated with the available attributes names.  Select the attribute name that 
represents the appropriate data.  For example, road number = rd_num, from milepost = bmp, and to 
milepost = emp. 
 
Now click “Continue…”  A progress screen will be displayed and will take several minutes to complete 
(Figure 1.2 C).  When the initialization completes a message will appear signifying that the process was 
either successful or unsuccessful.  If the process was successful you can begin using the Mobility map 
tool (continue reading for assistance).  If the process was unsuccessful, repeat the steps in the 
instructions and ensure the appropriate road base layer is selected, and the correct road number, from 
milepost, and to milepost attribute names are identified. 
 
Figure 1.2 C 
 

  
 
1.3 Make Map Tool Visible 
 
The map tool is contained in the tab “Map” on the main Mobility screen.  To make this tab visible, 
ensure “Map” is checked from the “Tools” menu (Figure 1.3 A).  If “Map” is checked the “Map” tab will 
appear next to the “Road List” tab directly below the road list sorting toolbar (Figure 1.3 B). 
 
 
 
 
 
 



Figure 1.3 A 
 

 
 
Figure 1.3 B 
 

 
 
 
 
 



2. Mobility Map Tool Orientation 
 
2.1 Mobility Map Toolbar 
 
The Mobility Map toolbar (Figure 2.1 A) allows for many actions to be performed on the map by clicking 
one of the icons.  This section will cover each one of the actions in detail. 
 
Figure 2.1 A 
 

 
 
2.1.1 Open Project 
 

Toolbar Icon =  
 
The Mobility map tool utilizes a project file for maintaining the state of the map when Mobility is closed.  
This “state” information includes which layers you had opened, which layers were active, what labels 
each layer has, etc. 
 
The “Open Project” toolbar command can be used to open a project file (extension .ttkgp), or to open a 
single layer to begin a new project.  By default your project file is saved when closing Mobility, and 
reloaded when Mobility is opened.   
 
2.1.2 Add Spatial Layer 
 

Toolbar Icon =  
 
The map supports multiple layers.  The “Add Spatial Layer” toolbar command can be used to append an 
ESRI Shape file layer.  These layers won’t be your Mobility data layers, but layers that may be useful with 
Mobility data, e.g., bodies of water, city boundaries, etc. 



2.1.3 Add Mobility Layer 
 

Toolbar Icon =  
 
Mobility layers are kept in a database, not ESRI Shape files.  The map initialization process creates layers 
for most of the linear Mobility inventories.  These layers can be added by clicking the “Add Mobility 
Layer” command.  A dialog will open with two options (Figure 2.1.3 A): 
 
Option 1:  Select From Existing Mobility Inventory Layers 
 
Option 2:  Create Custom Query 
 
Option 2 will create a new layer based off of the query written in the custom query window.  This 
custom query window is very similar to the one used in custom reports.  To access the custom query 
window click “Create Query.”  For help on writing custom reports see the Custom Report section of the 
Mobility help file. 
 
After selecting option 1 or 2 and identifying the layers to add to the map, click “Create Layer.” 
 
Figure 2.1.3 A 
 

 
 
 
 



2.1.4 Close All Layers 
 

Toolbar Icon =  
 
All layers will be closed immediately by clicking this toolbar command. 
 
2.1.5 Refresh 
 

Toolbar Icon =  
 
The static Mobility layers that are stored in the database are updated when changes are made to the 
inventory.  The Mobility map tool does not refresh automatically when changes are made to the 
database.  To get the latest changes to appear on the map, click the “Refresh” toolbar command. 
 
Note:  The refresh command does NOT refresh custom query layers. 
 
2.1.6 Print 
 

Toolbar Icon =  
 
This command will send the map to the printer. 
 
2.1.7 Save to Image 
 

Toolbar Icon =  
 
This command will save the map as an image to the CRAB FTP site. 
 
2.1.8 Full Extent 
 

Toolbar Icon =  
 
The “Full Extent” toolbar command will bring the entire map into view. 
 
 
2.1.9 Zoom Mode 
 
 

Toolbar Icon =  
 
Click the “Zoom Mode” command, the click and draw a box on the map to zoom to that area of the map.  
Drawing the box from left to right and top to bottom will zoom in, and any other direction will zoom out.  
The mouse wheel can also be used to zoom in and out. 
 
 
 



 
2.1.10 Pan Mode 
 

Toolbar Icon =  
 
Click the “Pan Mode” toolbar command, then click and hold the mouse down over the map pane.  Move 
the mouse up, down, left, and right to pan the map in those directions. 
 
2.1.11 Select Mode 
 

Toolbar Icon =  
 
Click the “Select Mode” toolbar command.  Select a layer from the layer pane.  When a layer is selected 
it will be highlighted yellow. Click an event on the map.  The selected event will flash yellow and red.  
After the event is done flashing it will remain red while selected.  The Attributes pane will fill with the 
attributes of the event.  If you have selected an event that belongs to a Mobility layer, the inventory 
form will open. 
 
2.1.12 Find 
 

Toolbar Icon =  
 
Click the “Find” toolbar command to open the find dialog (Figure 2.1.12 A).   
 

 
 
Follow these instructions to search: 
 

1. Select the layer you want to search 
2. Select “Visible Extent” (search only the area of the map that is visible) or “Full Extent” 

(search the entire map). 
3. Select the attribute you want to search on, e.g., road_number, federal function class, etc. 
4. Select the logical operator to use, i.e., =, <>, <, >, >=, <=. 

Note:  <> is the symbol for not equal to.  
5. Enter the value you would like to search on. 
6. Click “Search” 

 
After clicking search, the events on the map that match your search criteria will flash yellow and red. 
 
 
 



2.2 Layer Pane 
 
The layer pane (Figure 2.2 A) will list all layers currently loaded into the map tool.  If the checkbox to the 
left of each layer is checked, it will be visible on the map.  Unchecking the checkbox will hide the layer 
on the map.   
 
When a layer in the layer pane is clicked it will be highlighted yellow.  This makes the layer “active” 
when using the “Select Mode” toolbar command (see section 2.1.11).  Also, if you right click the “active” 
layer, the one highlighted yellow, a context menu will appear with options the either remove or export 
the layer.  Click “Remove Layer…” to remove the layer from the layer pane and the map tool.   Click 
“Export Layer…” to export the “active” layer to the CRAB FTP site. 
 
The order of the layers in the layer pane will determine the Z-order of the layers on the map.  The first 
layer in the layer pane will be the lowest layer in the map, and the next layer in the layer pane will be on 
top of the first layer in the map, so-on and so-forth.  If you would like to change the order of the layers, 
click and drag the layer in the layer pane to a different position. 
 
Lastly, if you double click a layer in the layer pane the properties dialog window will be opened.  These 
properties will be covered in Section 3:  Layer Properties Dialog. 
 
Figure 2.2 A 
 

 
 
 
 



2.3 Attribute Pane 
 
The attributes pane (Figure 2.3 A) will display the attributes associated with a selected event on the 
map.  For help selecting a map event see Section 2.1.11:  Select Mode. 
 
Figure 2.3 A 
 

 
 
2.4 Map Pane 
 
The map pane (Figure 2.4 A) displays the visible layers from the map pane. 
 

 



3.  Layer Properties Dialog 
 
Open the layer properties dialog (Figure 3 A) by double clicking a layer in the layer pane.  For more 
information on the layer pane see Section 2.2:  Layer Pane.  There are many options in the layers 
properties dialog and this section will cover a few of the most important.  You are encouraged to 
explore the properties dialog to discover different possibilities. 
 
Figure 3 A 
 

 
 
3.1 Change Layer Color, Width, Style, etc. 
 
There are three primary types of layers:  polyline, polygon, and point.  Polyline would be used for 
inventories such as roads, polygon is used for inventories like bodies of water, and point is used for 
inventories such as reference points.  This distinction is important when setting the color, width, or style 
of your layer.  The properties dialog has three tabs for this:  Line, Area, and Marker (Figure 3.1 A).  Line = 
Polyline, Area = Polygon, and Point = Marker. 
 
Figure 3.1 A 
 

 



3.2 Add Labels to Layer 
 
Add a label to your layer from the “Label” tab of the layer properties dialog (Figure 3.2 A).  From the 
“Label” tab use the drop down list under “Field” to select what attribute you want to use as your label.  
If you are setting a label for roadlog, or any polyline layer, you may want to set the label position to have 
the label follow the line (Figure 3.2 B). 
 
Figure 3.2 A 
 

  
 
Figure 3.2 B 
 

 



3.3 Property Wizard 
 
The property wizard (Figure 3.3 A) can be used to quickly render events in your layer based on the 
attributes.  For instance, a roadlog layer can be color coded by jurisdiction very easily. 
 
Figure 3.3 A 
 

 
 
4.  Glossary 
 

1.) Attribute:  Nonspatial information about a geographic feature in a GIS, usually in a table and 
linked to the feature by a unique identifier.  For example, attributes of a river might include its 
name, length, and sediment load at a gauging station. 

2.) Event:  A geographic location stored in tabular rather than spatial form.  Even types include 
roadlog segments, reference points, and street lights. 

3.) Layer:  The visual representation of a geographic dataset in any digital map environment.  
Conceptually, a layer is a slice or stratum of the geographic reality in a particular area, and is 
more or less equivalent to a legend item on a paper map.  On a road map, for example, roads, 
national parks, political boundaries, and rivers might be considered different layers. 

4.) Point:  A geometric element defined by a pair of x,y coordinates.  
5.) Polygon:  On a map, a closed shape defined by a connected sequence of x,y coordinate pairs, 

where the first and last coordinate pair are the same and all other pairs are unique. 



6.) Polyline:  a shape defined by one or more paths, in which a path is a series of connected 
segments.  If a polyline has more than one path (a multipart polyline), the paths may either 
branch or be discontinuous. 

7.) Shape:  The characteristic appearance or visible form of a geographic object as represented on a 
map.  A GIS uses points, line, and polygons to represent the shapes of geographic objects. 

8.) ShapeFile:  A vector data storage format for storing the location, shape, and attributes of 
geographic features.  A shapefile is stored in a set of related files and contains one feature class. 

9.) Spatial:  Related to or existing within space. 
10.)   Spatial Data:  Information about the locations and shapes of geographic features and the 

relationships between them, usually stored as coordinates and topology. 
 
This glossary covers the GIS terms used in this help.  The glossary definitions are provided from the ESRI 
Online GIS Dictionary.  For more GIS term definitions you can find the ESRI Online GIS Dictionary here:  
http://resources.arcgis.com/glossary/2/letters.   

http://resources.arcgis.com/glossary/2/letters


PAVEMENT MANAGEMENT SYSTEM
(PMS) TRAINING

 Definition

 Levels of PMS

 Components

 Pavement Manager

Database Updates

 Quality Control

 Technical User Groups

 Documentation
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What is a Pavement 
Management System?

PMS is a tool that can be used to make informed decisions 
about the Maintenance and Rehabilitation of a pavement 
network. 

WAC 136-70-040 Requirement– Pavement Management 
System - Minimum Standards 

2



Pavement Management System

Computer program for maintaining road surfaces by systematically 
analyzing pavement life cycles to:

Determine when to do pavement preservation

What is the most cost effective rehabilitation method 

Develop pavement rehabilitation budget that will prevent major road 

deterioration.

Federal Function Class (FFC) data as well as Truck Route Classifications are 
used extensively as critical data elements in the road rehabilitation 
selection process. 
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Levels of Pavement Management

Project Level: comes after network level, this level requires 
more detailed evaluation for a specific project.  Such as
cross-sections, topography and coring.

Network Level: the evaluation of all pavement under the 
agency’s jurisdiction.
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PMS Components

Inventory Data

Monitoring Data

Database

Data Analysis

System Outputs

Feedback
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What is a “Pavement Manager”?

This is the person that has the responsibility for:

Collecting, Managing, Analyzing and Communicating all 
information pertaining to the County’s Pavement network 
to numerous people within county government (PW 
Director, County Engineer, Elected Officials, Road Log 
Manager/Administrator,  Maintenance Staff and the 
Public)

This person is essential for reporting and submittal the 
annual Road Log updates and submittals to the County 
Road Administration Board. 
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PMS Database Updates

Control Fields 

New Roads

Road Re-alignment

Road Deletions (Vacations, Road Closures)

Maintenance History

PSC Ratings

Traffic Data Counts (aka ADT)

Jurisdictional Change

Pavement Type

Width changes – shoulders & thru lanes etc.
7



Quality Control

It is important to realize that the PMS is only as good as the 
data stored in the database.

Visual Data Collection – Using the Pavement Surface Condition 
Rating Manual for guidance. Seven (7) Core defects.

Quality Control - Data entry checking  10% minimum (self 
audit)

Garbage in Garbage out!!   (GIGO)
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Documentation

Flow Chart – tracking the process.

Written Instructions – step by step detailing your 
agencies’ procedures when using the PMS software.

Applications Guide – provides examples of ways to 
manipulate and analyze the data.
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Jump Start your PMS

Have a meeting with Engineering, Maintenance and other 
vested staff

Discuss expectations

Select guidelines for extent of information to be included in 
the network inventory

Data collected MUST serve a purpose

System output requirements, spreadsheets, charts,       
maps, and “canned reports”
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Technical User Groups

Engineering staff – project level information

Maintenance staff – identify crack seal and other defects 
that need to be addressed before rehabilitation begins

And of course the Pavement Manager
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Mobility PMS Data Requirements

Updated Road Log Information

Current (by WAC every 2 years) PSC ratings on Collectors 
and Arterials

Updated Surface/Structural History Information

ADT data (best-currently available)

Good Data provides the Best Results!!!!
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PAVEMENT MANAGEMENT 

If a Reasonable Level of Service is Provided at the Right Time, Right

Treatment and the Right Road.

With an effective preventive maintenance program the long term 

costs will be lower versus delayed rehab/reconstruction costs.

Maintains the roadway in a higher level of service for the public with 

overall reduced cost.

Preventive maintenance must be applied before the pavement                  

has deteriorated beyond preservation or it can be wasted 

money.
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Timing Of Treatments
Typical Pavement Life Curve

Excellent

Good

Fair

Poor

Very Poor

3 6 129 Years

Routine-$
Preventive-$$

Rehab-$$$

Rebuild

$$$$
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Maintenance Treatment Cost Comparison

Excellent

Good

Fair

Poor

Very Poor

5 7 2012 Years

Routine-$5.00 per sq. yd. (of roadway surface)

Preventive-$17.00per sq. yd.

Rehab-$53.00

per sq. yd.

Rebuild

$149.00

per sq. yd.

Pavement

Condition

Based on 2013 Average County Costs
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Decision Tree
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County Gas Tax Distribution Formula   (RCW 

46.68.122-124)

EQUAL

10%

ROAD COST

30%

EQUIVALENT

POPULATION

30%

NEEDS

30%

1/39 TO EACH COUNTYEQUIVALENT

POPULATION

ANNUAL

ROAD

COST*

ANNUAL NEEDS    

Unincorporated

Population                 

+

25% Incorporated

Population

Annual 

Maintenance Cost

+

Annual Road

Cost
-

Actual County Road Levy Amount + Federal Forest Funds +

State Timber Excise Tax + Island Counties Refund

* Includes all roads, bridges, ferries

1/25 

Replacement 

1
7



MOBILITY PMS

►Questions???
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Mobility User Training  

 

 

 

Pavement Management System 

 

Pavement Management System (PMS) is a methodology for maintaining road surfaces by systematically 

analyzing pavement life cycles and pavement ratings to determine timing of a pavement preservation, as 

well as the most cost effective pavement rehabilitation type. In addition, to develop pavement 

rehabilitation budgets that will prevent major road deterioration.  

 

The roadway and pavement information is in the County Road Log, and updated annually as part of the 

Road Log update process. The Mobility PMS uses the road log information directly; counties using 

another PMS program have a routine to transfer the current road log information to their program. 

The next step in building your PMS is to design a Decision Tree that best fits your county needs and 

expectations of your road network. A Decision Tree is a set of "Rules" by which each road segment is 

evaluated. A Rehabilitation Type, Rehabilitation Date, and Rehabilitation Cost are then calculated for 

each road segment based on your Decision Tree (see page 24 for an example). 

 

There are three levels of work on pavements: 

 Routine maintenance (pothole repair, patching, crack sealing, etc), done on an as-needed basis 

 Preservation or rehabilitation (installing a new wearing surface, a seal coat or overlay), done 

on a cyclic basis 

 Reconstruction (remove and replace the pavement and base structure), done when the road has 

failed or needs widening or realigning. 

 

There are three phases in the life of a pavement: 

 When the pavement is in good or better condition and does not need a preservation (PSC above 

60) 

 When a pavement preservation is cost effective (PSC between 60 and 40) 

 When the pavement is in such a poor condition that a pavement preservation is no longer cost 

effective (PSC less than 40), reconstruction is needed 

The year the pavement reaches the should and must levels is critical.  The should level is the PSC level 

where a rehabilitation should be considered.  If the PSC is above the should level, there is still life 

available in the pavement, and rehabilitation is not yet cost effective.  If PSC is below the must level, 

the pavement is in such a deteriorated condition that the road should be rebuilt and a surface 

rehabilitation will not be adequate to restore the road to its original condition. The should and must 

levels are selected by the user.  Typically the should level is a PSC of 60 (representing a 40% drop in 

quality) and the must level is a PSC of 40.  

By knowing when pavement preservation is cost effective, the county can spend their limited pavement 

preservation funds on the most cost-effective rehabilitations. By properly preserving their pavements, 

they reduce the need for and cost of routine pavement maintenance. 
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The 

results of the PMS program are not the final answer. The PMS results are but one of the items that must 

be considered during the engineering analysis of the proposed pavement preservation program. Each 

proposed project needs to be reviewed to make sure it is the right thing to do. 

 

The PMS strategy applied in Mobility Pavement Management System consists of four major parts:  

 

1. Surface Conditions – Recording visible distresses on the pavement surfaces, which are calculated 

into a Pavement Structural Condition (PSC) score.  Alligator Cracking and Patching are the highest 

deductions with the top 4  core structural pavement defects are – Transverse cracking, Longitudinal 

cracking, Alligator cracking,  and patching. At a minimum, counties are required to rate their Paved 

Arterial network (Arterial and Collector roads) every two years.   

 

2. Generate Project File - Define a road system as a rational set of projects.  

 

3. When Analysis - Formulate a Pavement Performance Curve to predict the PSC score for each project 

segment.  

 

4. What Analysis - Define and apply a budget and strategy, comparing the results of multiple iterations 

to determine the best course of action. 

 

Benefits 

A benefit of a Pavement Management System is the determination of whether a preservation activity 

will or will not be cost effective. One of the reports (Below Must) provided by the PMS is a list of all 

roads in such a poor condition that a preservation activity will not be cost effective, and that these roads 

need to be reconstructed. These roads need an in-depth engineering analysis to determine what should 

be done to improve the road. If reconstruction is needed, funds must be located, such as RAP funds for 

rural arterials, TIB funds for urban arterials, state and federal funds. 

The use of a PMS to determine if a preservation project is cost effective does not prevent the county 

from doing non-cost effective preservation projects. If it is determined that a preservation activity will 

be done, for whatever reason, that project will be done. The PMS provides an engineering reason for not 

doing the project, such that the pavement is in such poor condition that a pavement preservation will not 

last and is not cost effective.  

 

 PMS allows you to: Select the appropriate roads (Right Road) 

 Select the appropriate treatment (Right Treatment) 

 Choose the correct timing (Right Time) 

 Lowest cost treatment (with an effective preventive maintenance program the long term costs 

will be lower versus delayed rehabilitation/construction costs).  

 Greatest life expectancy (Preventive maintenance must be applied before the pavement has 

deteriorated beyond preservation or it can be wasted money. 
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Pavement life curve graph – costs increase significantly over 6-8 years and left alone pavements will typically 

deteriorate over time at increasing rate. 
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Decision Tree Rules Exercise 

 

Prior to creating the Decision Tree Rules, I would encourage everyone involved with the Road Maintenance 

Preservation program to sit down to discuss how you will define the rehabilitation types, cost (dollars per lane-

mile), projected life (years), and resulting PSC.   

First, review and update the rehabilitation list. The rehabilitation list can be accessed from the menu “Admin”  

“Pavement Rehabilitations”. The rehabilitation list contains rehabilitations available to the MPMS decision 

trees. When defining rehabilitations, provide a “Rehabilitation Description”, “Existing Pavement Type” (what 

pavement types the rehabilitation can be used on), “Cost (dollars per lane mile)”, “Projected Life (years)”, the 

“Resulting PSC”, and the “Resulting Pavement Type.” 

 

1.) Click on “Admin” on the upper menu bar then scroll down to “Manage Lookups”  

 

 

2.) Now click on “Manage Lookups”  

3.) Click on “Pavement Rehabilitations …”   

 

4.)  A dialog box will open for updating or creating new  “Pavement Rehabilitations”  (see following page) 
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1.) In addition to collaborating on the Rehabilitation values, agencies should also work together on assigning 

values in the Defined Values lookup table.  In this table, values for Should, Must and SMBP (Should Must Break 

Point) are defined.  These values are critical in the What Analysis.  No rehabilitations will be performed on 

projects with a PSC greater than the Should level, and no rehabilitations will be performed on projects with a PSC 

less than the Must level.  

 

2). Click on “Admin” on the upper menu bar then scroll down to “Manage Lookups”  

3.) Now click on “Lookup Tables”  
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5.) In the Lookup Table Maintenance, click on “Defined Values” drop down box   

 

 

 

 

Based on your own agency’s needs, values maybe modified. See below for examples – 

Code County A County B County C County D County E County F 

Must 45 40 50 39 40 00 

Should 71 70 70 81 75 65 

SMBP 56 55 60 00 55 80 
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Data Entry   

Creating a New Decision Tree   

1.) Click on “PMS” on the upper menu bar then scroll down to “Decision Trees”  

2.) Click “Edit decision trees” but do not edit the information on the screen!!!!   

 

3.) Go to the bottom of the form and click “New”  

4.) Now click on the “Name” box and type “2017 Training”  now press the tab key  

5.) In the Description Box type “PMS”  

6.) Now drop down and click the “Save” button  

This adds the “2017 Training” decision tree name to the list.  

7.) Now click the Close button  
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Creating New Decision Tree “Rules”  

1.) Click on “PMS” on the upper menu bar then scroll down to “Decision Trees”  

2.) Now click on “Edit decision tree rule collections”  

3.) In the “Select Decision Tree” drop down box click on right side down arrow and select “2017 

Training”  

 

4.) Now click the “New” button at the bottom of the form (even though the form is blank)  

5.) In the “Pavement Type” box click on the down arrow  

6.) Now click on “ACP” (bituminous concrete, sheet asphalt, rock asphalt)  

7.) In the “Rehabilitation” box, click on the down arrow  
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Decision Tree Rules Exercise continued  

  

8.) Now click on the 7th rehab down:  ACP 3/8 CHIP with Fog - $23,000 – BST – 7 

  

9.) Now click in “Item” box, now click on the down arrow.  

  

10.) Click on “PSC”  

  

11.) Click in “Operator” box, now click on the down arrow 
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12.) Click on greater than or = to (> =)  

  

13.) Now click in the far right “BreakPoint” box, now click on “SMBP”. 

  

14.) Now click the “Save” button on bottom of form.  

  

15.) Now click the “New” button at the bottom of the form and enter the Data from Group #2 from the 

Training decision Tree 2017.  

  

16.) In the “Pavement Type” box click on the down arrow  

  

17.) Then click on “ACP” (bituminous concrete, sheet asphalt, rock asphalt)  

  

18.) In the “Rehab” box, click on the down arrow  

  

19.) Then click on the 9th rehab down:  1½” Cl. B Overlay - $48,500 – ACP - 10  

  

20.) Now click in “Item” box,  now click on the down arrow  

  

21.) Click on “PSC”  

  

22.) Click in “Operator” box,  now click on the down arrow  

  

23.) Click on less than (<)  

  

24.) Now click in the far right “BreakPoint” box now click on “SMBP”  
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25.) Now click the “Save” button on the bottom of the form.  

  

Decision Tree Rules Exercise  

 

26.) Now click the “New” button at the bottom of the form and enter both lines of Data from Group #3 from 

the Training Decision Tree 2017.  

  

27.) In the “Pavement Type” box click on the down arrow  

  

28.) Now click on “BST” (low type Bituminous Surface-Treatment Road)  

  

29.) In the “Rehab” box, click on the down arrow  

  

30.) Now click on the 7th rehab down:  BST – 3/8” Chip with Fog - $12,000 –BST - 10  

  

31.) Now click in “Item” box, now click on the down arrow  

  

32.) Click on “Function Class Code”  

 

  
33.) Click in “Operator” box,  now click on the down arrow  

  

34.) Click on greater than or = to: (>=)  

  

35.) Now click in the first “Value” box,  now type the number “02”  (see following page) 
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36.) Now click in the “Item” box  in the Second Row, now click on the down arrow  

  

37.) Click on “Function Class Code”  

  

38.) Click in “Operator” box,  now click on the down arrow  

  

39.) Click on the less than or equal to :(<=)  

  

40.) Now click in the first “Value” box,  now type the number “19”  

  

41.) Now click the “Save” button on the bottom of the form.  

  

Now on your own enter data for group #4a (both lines) & #4b 

  

42.) Be sure to start by clicking the “New” button.  
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Configuring Your PMS  
  

Generate Project File   

1.) Go to the top menu bar and click on “PMS”  

 

 

  

 

2.) Now click on “Generate Project File”  

 

  

3.) Click on “View Settings” button, (under Project Generation Settings)  
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4.) Set “Max Project Length” to: 1.00 (miles)  

 

  

5.) Set “Default Pavement Year” to: 1985  

  

6.) Under “Jurisdiction to include” check the “County” box, now remove check in the  County,                

non-County Road box  

  

7.) Now click the “OK” button  

  

Project Generation starts, look in the upper right corner of the screen   
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Decision Tree Rules Exercise  

  

When Process:  

1.) Go to the top menu bar and click on “PMS”  

 

2.) Now click on “When” Analysis…  

  

 

Use the following settings for the “When” Analysis… (Change if necessary)  

  

Use ADT Data  “No”  

  

Use Ride Data  “No”  

 

Use NDT Curve Data  “No”  

  

 

  

 

 

3.) Now click the “OK” button  

“Project Generation” starts (see upper right of menu bar for percentage complete)  
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What 

Process – Option 1:  

  

4.) Go to the top menu bar and click on “PMS”  

  

5.) Now click on “What” analysis…  

  

Configure Analysis:  

                                   

6.) In Decision Tree box click on the “down arrow”  

  

7.) Now select “2017 Training”  

  

8.) In the “Start Year” box type in “2017”  

  

9.) In the “Repair Order” box click on the “down arrow”  

  

10.) Now select “Best First”  
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11.) In the “Use specified function class order?” box click on the “down arrow”  

  

12.) Now select “No”  

   

Budget Box:  

  

13.) Under Budget click on the “down arrow”  

  

14.) Now click on “Option 1” (below Option 1 is no longer grayed out)  

 

 

  

15.) In the “Option 1: Determine needed budget for…” click to highlight, then type the  number  “1” 

(year)  

  

16.) Now go to the bottom of the form and click the “OK” button  

  

Now look at the upper right corner of the screen and see the process percentage count  

 

Now the 1 Year Budget amount displays on the screen in a box.  
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What Process – Option 2:   

  

17.) Go to the top menu bar and click on “PMS”  

  

18.) Now click on “What” analysis…  

  

19.) Under Budget click on the “down arrow” now click on “Option 2”  

  

20.) Change Option 2: Determine network condition using specified budget for… “5 years”  

  

21.) Scheduled Maintenance of:  $0 per year  

  

22.) Available Funds of:  $1,000,000 per year  

 

23.) Total should equal     $1,000,000 
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24.) Now click the “OK” button on the bottom of the form  

  

Now look at the upper right corner of the screen and see the process percentage count.  

   

   

Pavement Management Reports:  

  

1.) Go to the top menu bar and click on “Reports”  

  

2.)  Click on “Pavement Management”  

  

 

3.) Now click on “Budget”  

  

4.) Change “Begin Year” to “2017” now hit the “tab” key  

   

5.) Now change “End Year” to “2021”  

  

6.) Now click on the “Generate” button (far right)  
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This canned report named “Pavement Management Budget Report” lists:  

      Rehab. years  

      Type of rehab.  

      Cost of rehab. 

      Total cost and total length of each rehabilitation type  

  

7.) To close the report click on the Red “X” in the upper right hand corner  

  

8.) Now go to the top menu bar and click on “Reports”  

  

9.) Go to the bottom of the list and click on “Pavement Management”  

  

10.) Now click on “Project List”  

  

11.) Change “Begin Year” to “2017” then hit the “tab” key  

   

12.) Now change “End Year” to “2021”  

  

13.) Leave “Project Type” blank for now  

  

14.) Now click on the “Generate” button (far right)  

 

This canned report named “Pavement Management Project List Report” list roads by:  

     Rehab. Year  

     Rehab. Type  

     Road #  

     Road Name  

     BMP  -  EMP  
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Rehab. Cost by Type  

     Total Cost of all Rehabs by Year  

  

15.) To close the report click on the Red “X” in the upper right hand corner  

 

16.) Now go to the top menu bar and click on “Reports”  

  

17.) Click on “Pavement Management”  

  

18.) Now click on “Network Conditions”  

  

 

 

19.)  Now click on the “Generate” button (far right)  
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Page 1 - First year analysis Average PSC 76 

 

Page 5 – 5 year analysis – Average PSC 55  

See page 6 for graph  
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                                                           2017 TRAINING 

                                                           DECISION TREE 

 

 
  

  

  

    Training Decision Tree    

  

Decision 
Group Surface 

    
Break 

Tree # Type Rehabilitation Item Operator Value Point 

Training 1 ACP 
3/8 Chip W/Fog  

 
PSC >= 

 
SMBP 

Training 2 ACP 1-1/2 Cl B Overlay PSC <  
 

SMBP 

Training 3 BST 
3/8 Chip W/Fog  

 
FC >= 02 

 

Training 3 BST 
3/8 Chip W/Fog  

 
FC <= 19 

 

Training 4 APC 
3/8 Chip W/Fog 

  
FC >= 02 

 

Training 4 APC 
3/8 Chip W/Fog  

 
FC <= 19 

 

Training 5 PCC Engineer Study PSC <= 
 

SHOULD 
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